Verify Tab
Click on the Verify tab to compare the measured and predicted max power
values. Their ratio, in percent, is the Performance Factor.

History Tab
Click on the History tab to view up to 20 recent measurements. This display is
useful for checking the consistency of string performance at a combiner box,
and for comparing steps in a troubleshooting process.

Meg Test Tab
Click on the Meg Test tab to record insulation test data taken with other
equipment. Click on Add Measurement to input new data points.

For more information:
More information about the analysis of the data is available in the
PVA-600 User’s Guide, which is accessible from the DVD, via the Help menu
in the PVA-600 Software interface, and on the Solmetric website.
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performance model, five dots will display along with the trace, representing the
predicted I-V curve shape. The red dot at the left predicts Isc. The dot at the
right predicts Voc. The middle dot predicts the maximum power point. The
second and fourth dots add additional definition to the curve. See the User Guide
for details.
Click the Environmental Inputs button to bring up the controls for selecting the
source of the irradiance and temperature information.
NOTE

If the Sandia Model is selected and the irradiance and
temperature are being determined From IV Data, the end
points of the measured I-V trace typically will typically match
the Isc and Voc values predicted by the PV model. If the 5
Parameter Model is selected and From IV Data is used, the
end points may not match the predicted points.
When using the wireless PVA Sensor Kit or manual sensors,
the end points typically will not exactly match the predicted
points when using the Sandia or 5 Parameter Performance
Models.

Copyright 2010 Solmetric Corporation. All rights reserved.
PVA-600 PV Analyzer
PC Software Version 2.0
Solmetric and the Solmetric PVA-600 PV Analyzer are either registered
trademarks or trademarks of the Solmetric Corporation in the United States
and/or other countries.

Table Tab
Click the Table tab to observe Predicted and Measured values.

Windows 7, Windows Vista, Excel, and Windows XP are trademarks of the
Microsoft Corporation registered in the U.S. and/or other countries.
90Solmetric Corporation, 117 Morris Street, Suite 100, Sebastopol, CA 95472,
USA Printed in the USA
All Solmetric packaging and paperwork are made from recycled or reused
materials.

The STC column translates measured values to STC conditions.
2
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Over-Current Protection
If greater than 20 A dc is applied to the I-V Measurement Unit, the PVA-600
detects the over-current condition and switches into disabled mode
automatically and an I-V measurement does not take place.
NOTE

Welcome!
Thank you for purchasing the Solmetric PVA-600 PV Analyzer. Please verify
that you have received all of the following items:

Conventional PV modules and strings may be measured in
parallel up to the specified maximum current of the PVA-600.
High-efficiency modules should NOT be measured in parallel.

•
•
•
•
•
•
•

Reverse Polarity Protection
If the I-V Measurement Unit is connected with the wrong polarity across a
string, the PVA-600 detects the condition and switches into disabled mode
automatically, and an I-V measurement does not take place.

I-V Measurement Unit
Soft Case
Wireless USB Adapter
PVA-600 Software
Battery Charger
MC-4 to MC-4 Connector-Saver Cable (1 pair)
MC-4 to MC-3 Adaptor Cables (1 set)

The User’s Guide is in electronic form only and is accessible from the DVD, via
the Help menu in the PVA-600 Software, and on the Solmetric website.

8. Viewing and Analyzing the Data

Be sure to visit our web site at:
www.solmetric.com for software updates and new products.

Once an I-V measurement has been taken, the data is presented in several forms
that are accessible via the tabs at the left edge of your screen.

Traces Tab

The Solmetric PVA-600 PV Analyzer

Click on the Traces tab for the I-V graph.
The PVA-600 PV Analyzer is a portable test instrument designed to measure the
current-voltage (I-V) curves of PV modules and strings and immediately
compare the results to the predictions of on-board PV models. Measurement
results are easily saved for future reference and analysis.

Safety and Regulatory
Before operating the PVA-600, familiarize yourself with the following
notations.
WARNING

The red and blue curves represent the measured I-V curve and the P-V (power
versus voltage) curve that is calculated from it. If you are using an advance
18
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A Warning calls attention to a procedure which, if not
performed correctly, could result in personal injury or loss of
life. Do not proceed beyond a warning note until the indicated
conditions are fully understood and met.

CAUTION

NOTE

A Caution calls attention to a procedure that, if not performed
correctly, could result in damage to, or destruction of, the
instrument. Do not proceed beyond a caution note until the
indicated conditions are fully understood and met.

A Note provides important or special information.

The IEC HV symbol indicates the presence of hazardous
voltages. Danger exists of electrical shock that can cause
severe injury or death.

Over-Temperature Protection
Built-in safeguards prevent the I-V Measurement Unit from operating at
potentially damaging internal temperatures.
Thermal Shutdown
When the internal temperature approaches the battery's high-temperature limit,
the measurement unit automatically shuts down (disables itself). To recover
from thermal shutdown, wait for the measurement unit to cool. Placing it in the
shade or a cool place will speed the recovery.
Operating Under High-Temperature Conditions
The most demanding thermal conditions for the measurement unit are:
•
•
•
•
•

Charging the Battery
The battery in the PVA-600 is not removable. It may be recharged by attaching
the battery charger to the connector on the PVA-600 shown below and plugging
the charger into an AC wall-plug.

Hot day
No wind
No shade
High open circuit voltage
I-V sweeps taken in rapid sequence

If you expect these conditions, plan ahead to minimize the temperature rise in
the I-V Measurement Unit. Shade the unit from direct sunlight, elevate it above
hot surfaces, and allow more time between I-V sweeps.
The I-V Measurement Unit is also equipped with a thermal fuse that will open
permanently when the temperature inside the unit reaches 85ºC. This condition
requires returning the unit to Solmetric for repair.

Over-Voltage Protection
Charging the battery takes 6 hours. Once the battery has been charged, the PVA600 will operate for approximately 2 days of normal use. During heavy use,
nightly charging is suggested.

If a voltage in excess of 650V dc is detected, the I-V Measurement Unit
switches into disabled mode. Clicking on the “Disabled” message in the Status
display pops up a warning that the voltage specification was exceeded and the IV Unit may have been damaged.

The PVA-600 Software interface will warn the user when approximately one
hour of battery life remains. Click on the Ready (Status) indicator within 5
minutes after any I-V measurement for a display of battery voltage.

WARNING

The software user interface displays the Disabled alert (above the Measure Now
button) when the battery is nearing the end of its charge. In this state, no
measurements can be taken.
4
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When the over-voltage condition is detected, the I-V Unit is
immediately reprogrammed to a disabled state to prevent
continued use of a damaged unit. Resetting the I-V Unit or
restarting the PC software will not re-enable it. Please contact
Solmetric support to arrange for repairs.

WARNING

NOTE

PV circuits continue to present danger of electrical shock
while system is paused. FAILURE TO TAKE
APPROPRIATE SAFETY PRECAUTIONS COULD LEAD
TO PERSONAL INJURY OR LOSS OF LIFE.

CAUTION

Do not operate the PVA-600 while charging.

WARNING

To prevent electrical shock, disconnect the PVA-600 from the
PV system and/or battery charger before cleaning. Use only a
dry cloth or cloth slightly dampened with water to clean the
external case and hard enclosure parts. Do not attempt to clean
internally.

If no measurements are taken for 15 minutes, the I-V
Measurement Unit will turn itself off to conserve battery.
Press the power button to turn it back on.

Environmental Inputs

Computer Minimum Requirements

Click the Environmental Inputs button to bring up the following controls:

Use the drop lists to select your source for irradiance and temperature data. Use
Wireless Sensor for best accuracy and speed. Select From IV Data for simple
curve shape measurements and for situations where you do not want to deploy
sensors.
NOTE
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Use the Adjust Sensors Cal… button to enter the wireless
sensor calibration from the label on the side of the irradiance
sensor, and to edit the Module Backside to PV Cell
Temperature Offset Factor. To calculate the PV cell
temperature, which is required by the PV models, the PVA
adds an offset to the measured backside temperature. It does
this on a prorated basis, adding the full, user-entered Wireless
Temperature Sensor Offset Value if the irradiance is
1000W/m2, and adding successively smaller offsets at lower
irradiance values, at which there is less heating.

•

Tested and Supported Operating System: Windows 7® (32 and 64 bit
versions), Windows Vista® (32 bit versions only), Windows XP® SP3

•

Two USB Ports (or one USB port plus a portable USB hub)

•

Display Resolution: 1024 X 600 (minimum)

•

Processor Speed: A Windows Experience Index (Processor component)
of 2.3 or greater is recommended. This value is available on your PC's
Control Panel under "Performance Information and Tools".

•

RAM: 1 GB minimum, 2 GB recommended

•

Available Disc Space: 100 MB or more

Systems that do not meet these requirements may not operate correctly.

PVA-600 Operational States
The PVA-600 can be in any of the following operational states:

5

•

Power off – LED off (I-V Measurement Unit is turned off)

•

Network search – LED blinking (press the power button once to turn
the Unit on and start it searching for the PC)

•

Sweep enabled – LED on (I-V network exists and sweep is enabled)

•

Sweeping – LED blinks once at start of each sweep when the I-V
Measurement Unit receives a sweep trigger from the PC.

•

Sweep disabled – LED off (press the power button once to disable the
I-V sweep)

•

Reset – LED blinking (press and hold the power button for more than 5
seconds to force a power-up type reset)

5.

8. Making I-V Measurements
Follow these steps, starting in the Traces tab (I-V curve screen):
1.

Specifications
•
•
•
•
•

Current Measurement Range:
Voltage Measurement Range:
Operating Temperature:
Storage Temperature:
Operating Humidity:

0 to 20 A dc
20 to 600 V dc
+0ºC to +50º C
-20ºC to +60º C
10 to 80%

See the User’s Guide for complete specifications.
NOTE

Ensure that the Temperature indicator blinks green approximately
every ten seconds. Follow the above steps if the signal level is low.

Conventional PV modules and strings may be measured in
parallel up to the current limit specified above. Highefficiency modules should NOT be measured in parallel.

Always keep Connector-Saver jumpers attached to the primary test leads to
extend the life of the primary PV connectors. To prevent damage to mating
connectors, replace the Connector-Saver jumpers when they have been
connected 100 times. Cut off the used-up connectors to prevent re-use.

PV/Electrical Safety Precautions

•

The status indicator button in the upper right corner of your screen
will blink Measuring while the measurement is being made and
the data processed. The red button on the I-V Measurement Unit
will blink once.

•

The first measurement takes longer because the I-V Measurement
Unit sends cal data to the PC (“Initializing”), and auto-ranges for
the type of PV device that is connected (“Optimizing”).

•

The I-V Measurement Unit measures a single I-V curve each time
the user clicks on the Measure Now button. I-V data is
transmitted to the PC shortly after each I-V sweep is taken.

2.

Save the trace by pressing the Assign and Save… button. When the
Array Navigator tree appears, click the string that you measured. Then
click the Assign and Save button to save your data to that tree location.
If you wish to display the PV model points but do not yet want to save
the trace, click the Assign button instead. If you are measuring more
than one string in parallel, highlight them all before saving.

3.

If you are measuring strings at a combiner box, lift the fuse of the
measured string and insert the fuse of the next string to be measured.
Repeat this measurement cycle until all strings have been measured.

4.

PV current is stopped automatically at the end of each I-V
measurement. To ensure that another sweep cannot accidentally be
started, press the power button to disable the measurement sequence.
Pressing the power button again re-enables the measurement unit. .

Precautions
PV Connectors

Click on the Measure Now button to start a measurement.

PV systems differ widely in design and construction. Therefore the guidance
provided in this section is general in nature.

WARNING
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Do not disconnect conductors from the tested string unless the
red power button on the I-V Measurement Unit is turned off.

Press the power button once on the I-V Measurement Unit.

WARNING

The operator must assess the potential dangers of each PV
system, and take appropriate precautions.
FAILURE TO
TAKE APPROPRIATE SAFETY PRECAUTIONS COULD
LEAD TO PERSONAL INJURY OR LOSS OF LIFE.

WARNING

Do not remove instrument covers. There are no user
serviceable parts within. Operation of the instrument in a
manner not specified by Solmetric may result in personal
injury or loss of life.

The LED will begin to blink indicating that the I-V Measurement Unit is
attempting to establish communication with the wireless USB adapter connected
to the PC. If the wireless USB adapter is inserted into an operating PC, a
network will be established and the LED will become continuously lit (no
blinking) and on your PC screen, the indicator above the “Measure Now” button
will turn green and say “Ready”. If a network is not established within 15
minutes, the I-V Measurement Unit will turn off to conserve the battery.

•

Do not work alone.

•

Do not use the PVA-600 in wet environments.

•

Wear electrical safety gloves and eye protection.

•

Assume that metal surfaces are energized unless proven otherwise.

If communications are not established within one minute:
1. Move the PC closer to the I-V Measurement Unit.
2. Reset the I-V Measurement Unit, by holding down the
power button for more than 5 seconds.
3. Remove and replace the Wireless USB Adapter.

•

Isolate the PV source circuit to be tested from the inverter and from
other PV source circuits before making any electrical connections to
the test device (PV module or string).

•

Always disable the measurement sequence using the LED-illuminated
pushbutton switch on the I-V unit before connecting or disconnecting
the test leads of the PVA-600.

7. Powering up the Wireless Sensor Kit

•

Connect the test leads to the test device (PV module, string, or array)
with the correct polarity.

If you are using the PVA Sensor Kit, perform the following:

•

Do not use the PVA-600 to test devices that produce more than the
instrument’s specified maximum current and voltage.

•

Do not operate at or subject the PVA-600 to temperatures beyond the
published operating and storage temperature specifications.

•

Inspect cables and connectors for damage before using. Do not use if
damaged.

•

Do not use the I-V Measurement Unit if it is damaged. Always inspect
for damage before using.

•

Do not use the I-V Measurement Unit if it is performing abnormally.
Contact Solmetric for guidance or return the I-V Measurement Unit to
the factory for service.

NOTE

1.

Insert the Wireless Sensor USB Adapter into a second USB port. If you
have only one USB port, use a notebook USB expander.

2.

Ensure that the PVA Sensor Kit is set up correctly.

3.

Turn on the sensor transmitters by pressing the I/0 button once. A green
LED will blink, but you may not be able to see it outdoors. A red LED
blinks three times when you turn the transmitter off.

4.
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Ensure that the Irradiance indicator on your PC screen blinks green
approximately every two seconds. If it is not blinking and few or no
‘bars’ are green, you may need to shorten the distance between
transmitter and PC or clear the line-of-sight to the transmitter.
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2.

Overview
Proper operation of the Solmetric PVA-600 includes the following steps:
1.

Installing the Software

2.

Setting up the PVA-600

3.

Setting up the Wireless Sensor Kit (Optional)

4.

Setting up a Performance Model

5.

Connecting to the PV Equipment

6.

Powering up the I-V Measurement Unit

7.

Making I-V Measurements

8.

Viewing and Analyzing the Data

WARNING

Each step is explained in this guide.

1. Installing the Software
1.
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Press the button on the I-V Measurement Unit to disable the I-V sweep.
The red LED indicator in the button should turn off.
PV circuits continue to present danger of electrical shock
when fuses are pulled and the PVA-600 system is paused.

3.

Following safe operating procedures, connect the PVA-600 to the test
string. The connection may be made at PV connectors at the ends of the
test string, or by clipping to the de-energized buss bars in a DC
combiner box, using suitable test leads with MC-4 connectors at one
end and insulated alligator clips at the other end.

4.

If one or both of the terminals of the test device must be some distance
from the I-V Measurement Unit, use extension cables made of UL (or
equivalent) listed PV wire, with correctly installed connectors. Select a
wire gauge that will introduce minimal voltage drop.

5.

When extension cables are longer than 10 feet (one-way), lay the cables
close to one another to minimize added cable inductance.

6.

If connecting at a fused combiner box, insert one fuse to select the
string to be measured.

Insert the PVA-600 DVD into the DVD drive on your Windows®
computer. Alternatively, the installation file is available at
www.solmetric.com. If the welcome screen does not automatically
open, double-click on the setup.exe file on the DVD or run
setup.exe from the Run dialog.

6. Powering-Up the I-V Measurement
Unit

2.

Follow the instructions in the welcome screen to install the PVA-600
software. The drivers for the wireless USB adapter will also be
installed.

Ensure that the PC is running the Solmetric PV Analyzer software, that the
wireless USB adapter is connected to the PC, and that the PVA-600 is properly
connected to the PV equipment.

3.

If requested, connect your PC to the internet to load prerequisites.

4.

When requested, insert the Wireless USB adapter in a USB port.

5.

When the installation process is finished, start the PVA-600 software
by double-clicking on the shortcut icon on your desktop as shown
below. Or, in the Start menu, select Programs>Solmetric>PV
Analyzer>Solmetric PV Analyzer.

NOTE
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If the “Ready” indicator does not appear within 30 seconds, to
to the Utility/Settings menu and select the port marked with
the “+” sign.

4.

In the Site Info page, enter the various site parameters. If web
connected, use Roof Measurement Tool… and Elevation… tools.
Enter azimuth and tilt from measurements or design documents.

5.

In the Array Navigator page, use the auto-configuration button to
create a tree representation of your PV system.

Special XP Operating System Instructions
This section applies to computers running the XP operating system only.

Select your inverter from the database (optional step). Enter Number
of Inverters. Click Using Combiners box if applicable. Enter the
number of Combiners, Strings, and Modules and click OK. You can
also use the other icons to create or edit your tree.

Older computers running the XP operating system require special steps during
the installation of the wireless USB driver. Please pay close attention to
onscreen prompts.
In addition, please be aware that XP will require the re-installation of the driver
if you insert the wireless USB adapter in a different USB port. Therefore, we
recommend one of the following when using the XP operating system:

To enable the PV model to account for wire losses for a string,
highlight the string in the tree and enter wire length & gauge. If you
highlight a combiner, inverter or system, all strings below the selected
level will be set to the length and gauge that you enter.
6.

WARNING
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Select a single convenient USB port for the wireless interface and
always use that port.

b.

Sequentially insert the wireless USB adapter into each USB port in
your computer and follow the same installation process (as instructed
on screen) for each port.

Press Finish to complete creating your Project.

5. Connecting to the PV Equipment

1.

a.

2. Setting Up the PVA-600

PV systems differ widely in design and construction.
Therefore the procedure described below is general in nature.
The operator must assess the potential dangers of each
particular PV system, and take appropriate safety precautions.
FAILURE TO TAKE APPROPRIATE SAFETY
PRECAUTIONS COULD LEAD TO PERSONAL INJURY
OR LOSS OF LIFE.

Isolate the PV module string to be tested (test string) from the inverter
and from other strings in the array. If the measurement is being made at
a fused DC combiner box, isolate the combiner box by means of the
DC disconnect switch, then isolate the PV strings from one another by
pulling their fuses.
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1.
2.

Place the I-V Measurement Unit close to the PV device to be measured.
Ensure that the Connector-Saver jumpers are installed on the primary
test leads.

3.

If using alligator clip leads or extension cables, connect them to the
connector-saver jumpers. Be sure these leads are rated for the
maximum current and voltage of the I-V Measurement Unit.

4.

If long extension cables are used, lay the cables alongside one another
to minimize the inductance they add to the measurement circuit path.

5.

Connect the Wireless USB Adapter to a USB port in your computer.

6.

If you will be using the PVA Sensor Kit, refer to the following section
for setup information.

CAUTION

In hot weather, place the PVA-600 in the shade to reduce the
likelihood of thermal shutdown. Don’t place the PVA-600 on
hot asphalt or the roof in direct sun.

NOTE

The PVA-600 will automatically shut down if its internal
temperature reaches a preset limit. Internal temperature is
increased by PV energy collected during I-V sweeps, and also
by heat absorbed from the environment, including high
ambient air temperature, hot surfaces on which the PVA-600
is placed, and exposure to direct sunlight.

3.

Position the irradiance sensor within at least 1-degree of the same plane
as the modules under test. For example, on the surface of a neighboring
module that is not in the string under test.

4.

Tape the tip of the temperature sensor firmly to the backside of a PV
module near the center of the module (away from the cooler edges).

5.

Turn on the sensor transmitters by pressing the I/0 button on each
transmitter. A green LED blinks (faintly) when the a transmitter is
turned on. A red LED blinks 3 times when it is turned off.

OTHER SENSOR KIT NOTES
Ensure that the transmitters are not resting on the ground or on the roof,
and are not placed against a metal surface. Elevating the transmitters
improves the transmission range.

3. Setting Up the Wireless Sensor Kit

When not in use, turn the transmitter power off to conserve battery life.

The PVA Sensor Kit (shown below) includes an irradiance sensor and a
temperature sensor. Each sensor is connected to a transmitter that communicates
wirelessly with the Sensor Wireless USB Adapter.

If the LOW BAT LED on either transmitter is blinking, replace the
battery with a freshly charged battery. You can substitute Alkaline
AAA batteries but battery life will be shorter

4. Setting Up a Project
The following procedure is used to set up a Project, which contains your PV
modeling and your I-V measurement data.

1.

2.

10

Before starting the PVA software, connect the Sensor Wireless USB
Adapter to a USB port in your computer. If a second USB position is
not available, a USB hub with short connecting cable may be used.
Ensure that the transmitter with the “I” label is connected to the
irradiance sensor, and that that the transmitter with the “T” label is
connected to the temperature sensor. Observe polarity markings.

1.

In the PVA-600 Software, drop down the File menu and select New
Project… The New Project Wizard will open.

2.

In the Notes / Info page, enter project name and notes.

3.

In the Performance Model page, click Select… to choose a PV
module manufacturer and name from the database. If your module is
not in the database, click the Custom radio button and click New…
Expand the Simple model and enter module datasheet values.

NOTE
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Enter temperature coefficients in units of % / C. If the
manufacturer supplies coefficients for Voc (STC) in units of V
/ C, this value can be converted to % / C by dividing the
supplied number by Voc and multiplying by 100.

